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1. Einführung 

Vielen Dank für den Erwerb von GIGAPORT eX. Dabei handelt es sich nicht nur um irgendein USB-
Audiointerface ... es ist derzeit die professionelle Lösung für die mehrkanalige Wiedergabe mit dem 
besten Preis- / Leistungsverhältnis auf dem Markt! 

Mit 8 unabhängigen Ausgängen (mit 7.1 Surroundsound-Unterstützung), 2 separaten Kopfhörer-
ausgängen und bester Audioqualität mit Support von bis zu 24-bit bei 192 kHz durch hochwertigste 
114dB Digital-nach-Analog Wandler, bietet GIGAPORT eX ASIO 2.0 Treiber für die professionelle 
Verarbeitung und Wiedergabe von Audiodaten unter Windows 7, Windows 8.1 und Windows 10. 
Die Hardware arbeitet auch nativ mit CoreAudio-Unterstützung unter OS X / macOS sogar ohne die 
Installation eines speziellen Treibers. Das macht GIGAPORT eX perfekt für DJ-Anwendungen, auch 
unterwegs. Verwenden Sie einfach die DJ-Software Ihrer Wahl und nutzen Sie die 8 Ausgänge als 4 
separate Stereoausgangspaare für Mix, Cue und Effekte! Über die beiden integrierten Kopfhörer-
ausgänge hören Sie Signale vor. GIGAPORT eX arbeitet selbstverständlich auch mit dem Desktop 
PC und ist kompatibel mit allen wichtigen professionellen DAW-Audioanwendungen. Die Hardware 
arbeitet mit praktisch jeder mehrkanaligen Audioanwendung, auch aus dem Consumer-Bereich. 

GIGAPORT eX ist ein USB-C Gerät, das für den USB 3.1 Anschluss optimiert wurde. Es ist ebenfalls 
zu herkömmlichen USB 2.0 Anschlüssen kompatibel. 

1.1 Leistungsmerkmale 

Die Vorderseite von GIGAPORT eX besitzt von links nach rechts die folgenden wichtigen Merkmale: 

 
 

- USB-C Anschluss zur Verbindung mit dem Computer oder Mobilgerät. Nutzen Sie diesen 
Anschluss, um das Gerät mit Ihrem Mac oder PC zu verbinden. Dazu verwenden Sie jeweils 
eines der mitgelieferten USB-C Kabel. Wenn das Gerät aktiviert ist, leuchtet das Power LED 
rechts neben dem USB-C Anschluss. 

- 8 Status-LEDs zur Anzeige von Aktivität auf dem entsprechenden Wiedergabekanal. Hier wird 
für jeden Kanal angezeigt, wenn Audiodaten abgespielt werden. 

- Kopfhörerausgang (1/2) mit unsymmetrischem 6.3mm Stereo-Klinkenanschluss für Kanal 1 
und 2. Über diesen Kopfhörerausgang wird immer das gleiche Signal abgespielt, das auch über 
den Line-Ausgang mit Kanal 1 und 2 ausgegeben wird. Diesen Kopfhöreranschluss können Sie 
somit nutzen, um Signale zur Kontrolle unabhängig von den Kanälen 3 bis 8 abzuhören, was 
insbesondere bei DJ-Anwendungen ohne ein externes Mischpult sinnvoll sein kann. 

- Kopfhörerausgang (Mix) mit unsymmetrischem 6.3mm Stereo-Klinkenanschluss für den 
Summenmix. Über diesen Kopfhörerausgang wird immer die Summe aller 8 (bzw. 4 Stereo-) 
Kanäle ausgegeben. Nutzen Sie den Ausgang beispielsweise zur Signalkontrolle für alle 
Wiedergabekanäle. 
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Die Rückseite verfügt über folgende Anschlüsse: 

 

- Line-Ausgang 1 bis 8 im unsymmetrischen Cinch-Format. Über diese Ausgänge werden die 
Signale abgespielt. Jeder Ausgangskanal ist entsprechend nummeriert / beschriftet. 
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2. Installation 

2.1 Systemanforderungen 

GIGAPORT eX ist mehr als nur eine herkömmliche Soundkarte – es handelt sich vielmehr um ein 
hochwertiges Audiointerface für den professionellen Einsatz. Aus diesem Grund kann das 
verwendete Computersystem eine wichtige Rolle bei der optimalen Performance von GIGAPORT 
eX spielen. Höherwertige Komponenten sind dabei durchaus zu empfehlen. 

Minimale Systemanforderungen 

PC 

- Windows 7 / 8 / 8.1 oder 10 (32- und 64-bit) Betriebssystem 
- 1 freier USB 2.0 oder USB 3.1 Anschluss ("Typ A" oder "Typ C") 

Mac 

- OS X / macOS 10.9 oder höher 
- 1 freier USB 2.0 oder USB 3.1 Anschluss ("Typ A" oder "Typ C") 

2.2 Hardwareinstallation 

GIGAPORT eX wird einfach an einen freien USB-Steckplatz angeschlossen. Der Anschluss am 
Computer ist wahlweise ein sogenannter "Typ A" oder ein "Typ C" Anschluss, für den jeweils ein 
eigenes Kabel beiliegt. Verbinden Sie ein Ende des mitgelieferten Kabels mit GIGAPORT eX und 
das andere mit Ihrem Computer. 

   
 USB "Typ A" Anschluss am Rechner USB "Typ C" Anschluss am Rechner 

2.3 Treiber- & Softwareinstallation 

Nach dem Anschluss von GIGAPORT eX wird das Betriebssystem automatisch eine neue Hardware 
erkennen. Um die Hardware mit allen Features zu nutzen, sollten Sie unseren Treiber installieren. 

Wir empfehlen dringend, den Treiber von unserer Webseite www.esi-audio.de herunterzuladen, um 
GIGAPORT eX einzurichten. Nur wenn unsere Treibersoftware installiert wird, stehen alle 
Funktionen unter Windows / OS X / macOS zur Verfügung! 

Sie finden immer jeweils die neuesten Treiber und Software für Mac und PC für Ihr 
GIGAPORT eX, wenn Sie auf folgende Seite in Ihrem Webbrowser zugreifen: 

>>>    http://de.esi.ms/110    <<< 
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2.3.1 Installation unter Windows 

Im Folgenden wird beschrieben, wie GIGAPORT eX unter Windows 10 installiert wird. Sollten Sie 
Windows 7, Windows 8 oder Windows 8.1 einsetzen, ist der Ablauf entsprechend. Verbinden Sie 
GIGAPORT eX mit Ihrem Computer noch nicht – falls Sie es schon angeschlossen haben, stecken 
Sie das Kabel zuerst aus. 

Sie starten die Installation per Doppelklick auf das Installationsprogramm, einer .exe Datei innerhalb 
des Treiberdownloads von unserer Webseite. Beim Start der Installation zeigt Windows unter 
Umständen einen Sicherheitshinweis an. Stellen Sie sicher, dass Sie die Installation zulassen. Der 
folgende Dialog links erscheint dann. Klicken Sie auf Next und der Dialog rechts wird angezeigt: 

   

Bestätigen Sie diesen durch Klick auf Install. Jetzt werden Dateien kopiert und nach einiger Zeit 
erscheint das folgende neue Fenster: 

 

Bestätigen Sie dieses durch Klick auf Weiter. Es werden erneut Dateien kopiert und möglicherweise 
erscheint nach einiger Zeit ein Windows-Sicherheitshinweis, wie hier zu sehen: 
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Bestätigen Sie diesen durch Klick auf Installieren. Nach einiger Zeit ist die Installation dann 
abgeschlossen und es erscheint dann der folgende Dialog: 

   

Wenn Sie das linke Fenster sehen, klicken Sie auf Fertig stellen. Anschließend wird in vielen Fällen 
das rechte Fenster erscheinen. Wir empfehlen, dass Sie dort Yes, restart the computer now wählen 
und auf Finish klicken, um den PC neuzustarten. 

Sie können GIGAPORT eX ab jetzt jederzeit, falls noch nicht geschehen, an den Rechner 
anschließen. Windows wird dann automatisch die Einrichtung vornehmen und Sie können da Gerät 
nutzen. 

Um die Treiberinstallation zu bestätigen, überprüfen Sie, ob das orangene ESI-Symbol in der 
Taskleiste (wie auf dem folgenden Bild zu sehen) auftaucht. 

 

Falls ja, ist die Treiberinstallation vollständig abgeschlossen. 
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2.3.2 Installation unter OS X / macOS 

Um GIGAPORT eX unter OS X / macOS einzusetzen, müssen Sie die Control Panel Software von 
einem Download von unserer Webseite installieren. Dieser Ablauf ist bei allen Versionen von OS X 
/ macOS praktisch gleich. 

Das Control Panel wird installiert, indem Sie einen Doppelklick auf die .dmg Datei machen. Dann 
erscheint dieses Fenster im Finder: 

 

Um das GIGAPORT eX Panel zu installieren, klicken Sie mit der Maus darauf und ziehen sie nach 
links auf Applications - dadurch wird es in Ihren Programme-Ordner kopiert. 

Die Steuerung einiger Optionen von GIGAPORT eX unter OS X / macOS ist auch über die Audio-
MIDI-Konfiguration von Apple möglich (aus dem Ordner Programme > Dienstprogramme), 
allerdings wird für die Nutzung aller Funktionen unsere spezielle Control Panel Anwendung benötigt, 
die sich nun in Ihrem Programme Ordner befindet. 
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3. Windows Control Panel 

Dieses Kapitel beschreibt das GIGAPORT eX Control Panel und seine Funktionen unter Windows. 
Es wird über Doppelklick auf das orangene ESI-Symbol in der Taskleiste geöffnet. Das folgende 
Fenster erscheint anschließend: 

 

Das File-Menu beinhaltet die Option Always on Top so, dass das Control Panel immer angezeigt 
werden kann, wenn Sie mit anderer Software arbeiten. Über Windows Audio Settings können Sie die 
Windows-Audioeinstellungen aufrufen. Im Config-Menu können über Factory Defaults die Werks-
einstellungen geladen werden und Help > About zeigt Versionsinfos an. Gleich unter dem File, 
Config, DirectWIRE und Help Menu sind die folgenden Funktionen und Bereiche unter OUTPUTS: 

1 / 2, 3 / 4, 5 / 6 und 7 / 8 

Hier finden Sie Lautstärkeregler für das Wiedergabesignal immer je für ein (Stereo-)Kanalpaar. Unter 
jedem Regler finden Sie den Mute-Schalter (M), zum Stummschalten des Signals und dazwischen 
eine Pegelanzeige. Um den linken und rechten Kanal gleichzeitig zu steuern (Stereo), muss die LINK 
Funktion aktiviert werden. Ist LINK deaktiviert, wird jeder Kanal unabhängig gesteuert. 

MASTER 

Hier finden Sie Lautstärkeregler für das Wiedergabesignal der Summe aller Kanäle. Unter den je-
weiligen Reglern finden Sie einen Mute-Schalter (M), zum Stummschalten des Signals und dazwi-
schen eine Pegelanzeige. Um den linken und rechten Kanal gleichzeitig zu steuern (Stereo), muss die 
LINK Funktion darunter aktiviert werden. Ist LINK deaktiviert, wird der Kanal unabhängig gesteuert. 

SAMPLERATE 

Im unteren Bereich wird die aktuell verwendete Samplerate angezeigt, die im Menu über Config > 
Samplerate auch geändert werden kann (solange keine Audiosignale abgespielt werden). Da 
GIGAPORT eX ein digitales Audiointerface ist, werden zur gleichen Zeit die Audiodaten aller 
Anwendungen immer mit der gleichen Samplerate verarbeitet. Nativ werden Sampleraten zwischen 
44.1 und 192 kHz unterstützt. 
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3.1 Latenz- und Puffereinstellungen 

Über den Menupunkt Config > Latency im Control Panel kann die Latenzzeit für den Treiber von 
GIGAPORT eX eingestellt werden. Eine kleinere Latenzzeit ergibt sich durch Auswahl einer 
kleineren Puffergröße. Je nach Anwendung (z.B. für die Wiedergabe von Softwaresynthesizern) ist 
eine kleinere Latenzzeit von Vorteil. Gleichzeitig hängt die Latenzzeit auch indirekt mit der Perfor-
mance Ihres Systems zusammen und hängt auch von der Systemauslastung (z.B. die Anzahl aktiver 
Kanäle und Plugins) ab, was eine Erhöhung der Latenzzeit notwendig machen kann. Der Latenzpuffer 
wird in der Einheit samples eingestellt, wobei diese in eine Zeit in Millisekunden umgerechnet 
werden kann, die von einigen Audioanwendungen in den Einstellungen angezeigt wird. Beachten Sie, 
dass die Latenz eingestellt werden muss, bevor Sie Anwendungen starten, die GIGAPORT eX nutzen. 

Über Config > USB Buffer können Sie die Anzahl der USB Datentransferpuffer, die der Treiber 
verwendet, einstellen. In den meisten Fällen ist es nicht notwendig, diese Einstellung zu ändern, da 
sie jedoch auch einen kleineren Einfluss auf die Audiolatenzzeit hat und auf die Stabilität, können 
Sie diesen Wert optimieren. Welcher Wert auf Ihrem System sinnvoll ist, hängt von einigen Faktoren 
ab, wie z.B. die gleichzeitige Verwendung anderer USB-Hardware und von dem in Ihrem PC 
eingebauten USB-Controllerchip. 

3.2 DirectWIRE Output Channels 

Unter Windows stellt GIGAPORT eX eine Funktion bereit, die wir DirectWIRE Output Channels 
nennen. Damit ist es möglich, die Kanalzuordnung für die Wiedergabe (auch bei laufender 
Wiedergabe in Echtzeit) zwischen der Audioanwendung und dem physikalischen Ausgang zu ändern. 

Hinweis: DirectWIRE ist sehr leistungsfähig und wird nur für besondere professionelle 
Anwendungen eingesetzt. In vielen Fällen benötigen Sie DirectWIRE nicht und sie sollten hier keine 
Veränderungen vornehmen. Machen Sie dies nur, wenn sie wissen wozu. 

Um die zugehörigen Einstellungen zu machen, klicken Sie auf DirectWIRE > Output Channels im 
oberen Menu des Control Panels. Folgender Dialog erscheint dann: 

 

In diesem Dialog sehen Sie 8 Ausgangskanäle. Die linke Spalte listet die physikalischen Ausgänge 
von GIGAPORT eX. Die rechte Spalte listet die Wiedergabekanäle aus Ihren Audioanwendungen 
(die Wiedergabe z.B. über Kanal 1 und 2 wird hier mit 1 und 2 angezeigt). Standardmäßig sind 
Wiedergabekanal 1 (rechts) an Ausgang 1 (links), Wiedergabekanal 2 an Ausgang 2 (und so weiter) 
zugeordnet. 
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Mit dem - und + Schalter jeweils neben den Wiedergabekanälen kann die Zuordnung angepasst 
werden. Über STEREO LINK unten ist es zudem zusätzlich möglich, sicherzustellen, dass Ver-
änderungen immer als Stereo-Kanalpaar gemacht werden. 

DirectWIRE Output Channels Beispiele 

Hier ist eine Beispielkonfiguration abgebildet: 

 

Bei diesem Beispiel wird das Signal von Wiedergabekanal 5 / 6 an die Ausgänge 1 und 2, das Signal 
von Wiedergabekanal 1 / 2 an die Ausgänge 3 und 4, das Signal von Wiedergabekanal 3 / 4 an die 
Ausgänge 5 und 6 und das Signal von Wiedergabekanal 7 / 8 an die Ausgänge 7 und 8geschickt. Die 
Einstellungen wurden mit aktiviertem STEREO LINK vorgenommen. 

Hier ein anderes interessantes Beispiel: 

 

Bei diesem Setup erhalten alle physikalischen Ausgangskanalpaare das Wiedergabesignal von Kanal 
1 / 2, d.h. dieses Signal wird sozusagen auf alle physikalischen Ausgänge 'kopiert'. 

Diese Parameter können im laufenden Betrieb, sogar während der Wiedergabe, geändert werden. Um 
alles zurückzusetzen, klicken Sie die rechte Maustaste im Dialog und dann auf Reset routing to default. 
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3.3 Windows Audio-Einstellungen 

Im Sound-Dialog der Windows Systemsteuerung, den Sie auch über File > Windows Audio Settings, 
aus unserem Control Panel aufrufen können, finden Sie die Wiedergabe- und Aufnahme-Bereiche:  

   

Sie sehen im Wiedergabe-Bereich 4 Geräte, jeweils für einen Stereokanal (GIGAPORT eX CH1&2, 
GIGAPORT eX CH3&4, GIGAPORT eX CH5&6 und GIGAPORT eX CH7&8). Jede dieser 
sogenannten MME/WDM Geräte repräsentiert ein Kanalpaar für die Wiedergabe, das standardmäßig 
dem entsprechend nummerierten physikalischen Ausgang zugeordnet ist. Es kann sehr praktisch sein, 
diese separaten Geräte zu nutzen, da so mehrere unterschiedliche Anwendungen gleichzeitig auf 
unterschiedliche Kanäle zugreifen können oder da Sie Anwendungen nutzen können, die gleichzeitig 
unterschiedliche Geräte für unterschiedliche Funktionen verwenden können. 

Der Wiedergabe-Bereich enthält auch ein Lautsprecher Gerät vom GIGAPORT eX Audio driver, der 
in vielen Fällen als Standardgerät verwendet werden sollte. Dieses Gerät kann für die Wiedergabe 
mit allen (bis zu 8) Kanälen genutzt werden. Einige Anwendungen setzen voraus, dass Sie über 
Konfigurieren > Lautsprecher-Setup die Anzahl der Ausgangskanäle festlegen: Stereo (= 2 Wieder-
gabekanäle), Quadrophonie (= 4 Wiedergabekanäle), 5.1 Surround (= 6 Wiedergabekanäle), 6.1 
Surround (= 7 Wiedergabekanäle) oder 7.1 Surround (= 8 Wiedergabekanäle). Wählen Sie einen der 
Einträge aus, um zu definieren, wie viele Ausgangskanäle Sie gleichzeitig nutzen möchten 
(empfohlen ist 7.1 Surround). 

Bitte beachten Sie, dass auch andere Audiohardware, die bereits in Ihrem Computer eingebaut ist, im 
Sound-Dialog aufgelistet wird. Sie sollten deswegen das gewünschte Standardgerät auswählen (z.B. 
für die Wiedergabe der Systemsounds oder aus Ihrem Web-Browser). Um das Standardgerät 
festzulegen, klicken Sie darauf und anschließend auf Als Standard. 

Beachten Sie auch, dass viele (vor allem professionelle) Audioanwendungen selbst ihre eigenen 
Einstellungsbereiche hierfür haben und dass Audioanwendungen, die die ASIO-Unterstützung von 
GIGAPORT eX verwenden, die Einstellungen hier ignorieren und direkt auf die Hardware zugreifen. 



ESI GIGAPORT eX

 

 14

3.4 DirectWIRE Loopback 

GIGAPORT eX unterstützt die DirectWIRE Loopback Funktionalität. Damit können Sie 
Wiedergabesignale intern aufzeichnen. Zum Beispiel können Sie Audiosignale in einer beliebigen 
Anwendung abspielen, während Sie sie mit einer anderen aufzeichnen. Oder Sie nehmen das 
Summensignal vom DJ Mix auf dem gleichen Computer auf. Es gibt unzählige Anwendungsmög-
lichkeiten, so kann z.B. auch das Streaming oder die Wiedergabe eines Softwaresynthesizers 
abgespeichert werden. Im Prinzip können Sie 1:1 identische Transfers von allen digital abgespielten 
Audiosignalen innerhalb Ihres Systems erstellen. 

Sie erkennen im Sound-Dialog der Windows-Systemsteuerung, dass es auch ein MME/WDM 
Aufnahmegerät mit der Bezeichnung GIGAPORT eX Loopback gibt (in der Abbildung im vorherigen 
Abschnitt zu sehen). Auch ASIO-kompatible Anwendungen können 2 Eingangskanäle nutzen. Es 
funktioniert so, dass alles, was über die physikalischen Ausgangskanäle 1 und 2 abspielen, innerhalb 
der gleichen oder mit einer anderen Anwendung intern direkt aufgezeichnet werden kann. 

Bitte beachten Sie, dass Signale, die Sie via Ausgänge 3 bis 8 abspielen, nicht intern aufzeichnen 
können – das geht nur mit dem Ausgangssignal von 1 und 2. Sie können die anderen Signale jedoch 
trotzdem dem physikalischen Ausgang 1 und 2 und damit der internen Aufnahmemöglichkeit über 
die DirectWIRE Output Channels Funktion (bereits beschrieben), zuordnen. 
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4. OS X / macOS Control Panel 

Dieses Kapitel beschreibt das GIGAPORT eX Control Panel und seine Funktionen auf dem Mac. Es 
wird über Doppelklick auf das GIGAPORT eX Symbol in Ihrem Programme-Ordner aufgerufen. Das 
folgende Fenster erscheint anschließend: 

 

Das File-Menu beinhaltet die Option Always on Top mit der es möglich ist, dass das Control Panel 
auch immer dann angezeigt wird, wenn Sie mit anderer Software arbeiten. Über macOS Audio 
Settings können Sie die Audioeinstellungen von OS X / macOS aufrufen. Im Config-Menu können 
über Factory Defaults die Werkseinstellungen geladen werden und Help > About zeigt Versions-
informationen an. Der Hauptdialog hat folgende Bereiche unter OUTPUTS: 

1 / 2, 3 / 4, 5 / 6 und 7 / 8 

In diesem Bereich finden Sie Lautstärkeregler für das Wiedergabesignal immer jeweils für ein 
(Stereo-)Kanalpaar. Unter jedem Regler finden Sie den Mute-Schalter (M), zum Stummschalten des 
Signals. Um den linken und rechten Kanal gleichzeitig zu steuern (Stereo), muss die LINK Funktion 
darunter aktiviert werden. Ist LINK deaktiviert, wird jeder Kanal unabhängig gesteuert. 

MASTER 

In diesem Bereich finden Sie Lautstärkeregler für das Wiedergabesignal der Summe aller Kanäle. 
Unter den jeweiligen Reglern finden Sie einen Mute-Schalter (M), zum Stummschalten des Signals. 
Um den linken und rechten Kanal gleichzeitig zu steuern (Stereo), muss die LINK Funktion darunter 
aktiviert werden. Ist LINK deaktiviert, wird jeder Kanal unabhängig gesteuert. 

SAMPLERATE 

Im unteren Bereich wird die aktuell verwendete Samplerate angezeigt, die im Menu über Config > 
Samplerate auch geändert werden kann (solange keine Audiosignale abgespielt werden). Da 
GIGAPORT eX ein digitales Audiointerface ist, werden zur gleichen Zeit die Audiodaten aller 
Anwendungen immer mit der gleichen Samplerate verarbeitet. Nativ werden Sampleraten zwischen 
44.1 und 192 kHz unterstützt. 
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4.1 Latenz- und Puffereinstellungen 

Im Gegensatz zu Windows, werden unter OS X / macOS die Latenz-relevanten Einstellungen 
abhängig von der verwendeten Audioanwendung (z.B. DAW) verwaltet und normalerweise dort und 
nicht in unserem Control Panel eingestellt. Wenn Sie dazu mehr erfahren möchten, beachten Sie die 
Dokumentation Ihrer Audiosoftware. 

4.2 OS X / macOS Audio-Einstellungen 

Die Audio-MIDI-Konfiguration von Apple (zu finden unter Programme > Dienstprogramme oder 
über File > macOS Audio Settings in unserem Control Panel abzurufen) listet GIGAPORT eX als 
Gerät mit 2 Eingängen und mit 8 Ausgängen. 

Der Bereich Ausgang unter Audiogeräte sieht so aus: 

 

Hier sehen Sie alle 8 Ausgangskanäle und Sie können dafür jeweils die Lautstärke einstellen. Unter 
Format kann die Standard-Samplerate und -Auflösung eingestellt werden. 

Der Bereich Eingang sieht so aus: 
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Die beiden Eingangskanäle, die hier angezeigt werden, können für die DirectWIRE Loopback 
Funktionalität verwendet werden (wird im nächsten Abschnitt beschrieben). Unter Format kann die 
Standard-Samplerate und -Auflösung eingestellt werden. 

4.3 DirectWIRE Loopback 

GIGAPORT eX unterstützt die DirectWIRE Loopback Funktionalität. Damit können Sie 
Wiedergabesignale intern aufzeichnen. Zum Beispiel können Sie Audiosignale in einer beliebigen 
Anwendung abspielen, während Sie sie mit einer anderen aufzeichnen. Oder Sie nehmen das 
Summensignal vom DJ Mix auf dem gleichen Computer auf. Es gibt unzählige Anwendungsmög-
lichkeiten, so kann z.B. auch das Streaming oder die Wiedergabe eines Softwaresynthesizers 
abgespeichert werden. Im Prinzip können Sie 1:1 identische Transfers von allen digital abgespielten 
Audiosignalen innerhalb Ihres Systems erstellen. 

Sie können feststellen, dass in den Anwendungen auch 2 Eingangskanäle zur Verfügung stehen 
(intern werden diese als Loopback 1 und Loopback 2 bezeichnet, während sie in den meisten 
Anwendungen schlicht als GIGAPORT eX angezeigt werden). Es funktioniert so, dass alles, was 
über die physikalischen Ausgangskanäle 1 und 2 abspielen, innerhalb der gleichen oder mit einer 
anderen Anwendung intern direkt aufgezeichnet werden kann. 

Bitte beachten Sie, dass Signale, die Sie via Ausgänge 3 bis 8 abspielen, nicht intern aufzeichnen 
können – das geht nur mit dem Ausgangssignal von 1 und 2. 
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5. Technische Daten 

- USB 3.1 Audiointerface mit USB-C Anschluss ("Typ C" nach "Typ C" Kabel mitgeliefert) 

- USB 2.0 kompatibel ("Typ A" nach "Typ C" Kabel mitgeliefert) 

- Stromversorgung über den USB Bus 

- 8 unabhängige Ausgangskanäle mit -10dBV Cinch-Anschlüssen 

- 2 unabhängige Stereo-Kopfhörerausgänge 
- der 1. sendet die Summe aller Wiedergabesignale 
- der 2. sendet das Wiedergabesignal von Kanal ½ 
- beide mit 6.3mm Stereo Klinkenanschluss 
- max. Ausgangspegel +6.4dBu (@ 0dBFS) 
- THD+N 0.0024% A-gewichtet (@ fs=48kHz)  
- 32~600 Ohm Impedanz 

- 24-bit / 192 kHz D/A-Wandler, für alle Ausgangskanäle 
- 114dB Dynamikumfang A-gewichtet 
- THD+N -100dB (@ 0dBFS) 

- DirectWIRE Output Routing Unterstützung unter Windows für flexibles Signalrouting 

- DirectWIRE Loopback-Unterstützung für 2 Kanäle unter Windows und OS X / mac OS 

- unterstützt Windows 7 / 8 / 8.1 / 10 mit ASIO 2.0, MME, WDM und DirectSound 

- unterstützt OS X / macOS (10.9 und höher) über den native CoreAudio USB-Audiotreiber von 
Apple (keine Treiberinstallation notwendig) 

- 100% Class Compliant (keine Treiberinstallation bei vielen modernen Betriebssystemen 
notwendig, wie beispielsweise Linux mit ALSA oder bei iOS- und anderen mobile Geräten) 
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6. Allgemeine Hinweise 

Warenzeichen 

ESI. GIGAPORT und GIGAPORT eX sind Warenzeichen von ESI Audiotechnik GmbH. Windows 
ist ein eingetragenes Warenzeichen der Microsoft Corporation. Andere Produkt- und Markennamen 
sind Warenzeichen oder eingetragene Warenzeichen der jeweiligen Eigentümer. 

Kontakt 

Für technische Supportanfragen wenden Sie sich bitte an Ihren örtlichen Händler bzw. lokalen 
Vertrieb für ESI. Online finden Sie Support- und Kontaktinformation unter www.esi-audio.de. In 
Deutschland erreichen Sie den technischen Support auch telefonisch unter 07152 / 398880. 

Weitere Hinweise 

Alle Leistungsmerkmale, Spezifikationen und weitere Angaben können jederzeit ohne Ankündigung 
geändert. 

Teile dieses Handbuch können in Zukunft geändert werden. Bitte beachten Sie die Hinweise auf 
unserer Webseite www.esi-audio.de mit aktuellen Informationen. 


